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WELCOME CENTER
Windows Vista greatly simplifies the process of setting up a new computer—the new Welcome Center 
makes it easier than ever. This screen pulls all the tasks you'll most likely want to complete when you set 
up your computer into a single location.

If you need to know the details of your computer, setup a network or transfer files from your old computer 
this will help.

Such tasks include connecting to the Internet, adding user accounts for different people, and transferring 
files and settings from another computer using Windows Easy Transfer.

Welcome Center automatically appears when you use the computer for the first time. You can choose to 
have it appear every time you start your computer or turn it off by unchecking the box on the bottom of the 
screen.

WINDOWS MEDIA PLAYER
Windows Media Player is a useful, free tool for listening to music on your computer. You can also use it to 
burn music to disk and rip music to your computer. Windows Media Player also acts as a browser to 
search for media online. The software is compatible with Digital Rights Management (DRM) music which 
is available for free on many websites. 

Step 1

Open Windows Media Player . Right click on the bar at the top. From the menu, select "Tools" and 
"Options." Click the "File Types" tab. Select the file types you would like to open Windows Media 
Player automatically. Examples of file types to select include Windows Media Video (WMV), Windows 
Media Audio (WMA), MP3 and AVI.

Step 2

Click "Library" in the toolbar at the top. Then select "Add to Library." Select the folders you would like 
to monitor. Windows Media  Player will automatically add music from these folders as you download 
or rip it to your computer.

Step 3

Select the piece you would like to play in the Library view. Click the "Play" button at the bottom of 
Windows Media Player. This button looks like a triangle facing the right side of the screen. Press the 
button with the double bars to pause the playback. Press the square button to stop playback. The 
double arrow buttons fast forward and rewind the file.

Step 4
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Click the blue arrow in the upper right hand corner to show the list pane. Drag the albums or songs 
from the library pane to the pane on the right to create a playlist. Click "Save Playlist" and give the list 
a name if you would like to listen to it again.

Step 5

Click the "Now Playing" tab to view visualizations. Right-click on the toolbar at the top then select 
"Tools," "Download," and "Visualizations" to get more visualizations from the Windows website.

Step 6

Click "Burn" to copy music you have purchased from the web. To burn music, insert a blank, 
formatted CD into your rewritable disk drive.

Step 7

Click "Rip" to copy music from CD onto your hard drive. Insert the CD into the drive. It will begin to rip 
automatically if you have the left default settings intact. Click any songs that you do not want to rip to 
your computer.

Step 8

Click the "Media Guide" button to browse music, movies and TV to purchase. Click the "Radio" link to 
search online radio stations for the music you'd like to hear.

WINDOWS MEDIA CENTER

Windows Media Center has many benefits depending on the needs of a particular user and how the 
system is setup. Windows Media Center can be used to connect many types of electrical components 
ranging from a DVD player to a high-definition television. Now you have images, movies, music and 
television all from one piece of equipment. 

Recording

Windows Media Center can be used as a DVR to record movies and television programming. A TV 
tuner card is required to watch and record video from a source such as cable or satellite. Unlike a 
DVR system from a cable or satellite provider, there is no monthly fee to record programming using 
Windows Media Center. 

Programming Guide

Windows Media Center comes with an electronic programming guide that can be used to determine 
the start time for a particular program. Programs can be scheduled in the programming guide to 
record a single episode or an entire series. You can search programs by title or genre as well as 
scheduled to record programs as many as 14 days in advance. 

Playing Media

Windows Media Center can be used to store and play different types of media such as music files 
using the music library. Media Center has the ability to burn a CD and create playlists for favorite 



artists or for a specific type of music. You can also access and listen to FM radio stations through the 
Windows Media Center. The Center can also be used to buy music from various online sources. 

Accessibility

Windows Media Center provides the ability to access the computer from up to five rooms in a house 
using an extender (see Additional Resources). An extender is a device that can bring your digital 
media from Windows Media Center to any television in your house using only a remote. Use of an 
extender requires Windows Vista and a wired or wireless home network. In addition, Xbox 360 has a 
built-in extender that can link to Windows Media Center. 

Archiving

Newer versions of Windows Media Center offer the ability to archive television programming directly 
to a DVD disk. This feature means that you don't need to store a television program on your computer 
in the Media Center to keep them. Instead, you can program Windows Media Center to burn them 
directly to DVD. 

Setup

When you are ready to use Media Center, the video should be optimized, and the speakers should be 
set up to work correctly on the system. You can use the Express Setup or Custom Setup options to 
get the Media Center up and running quickly. Access Express Setup by pressing the green "Start" 
button on the Windows Media Center Remote or by using the mouse. Additional video display options 
can be found under "Adjust video display controls" in Media Center. You can set up surround sound 
speakers by using the speaker setup process. Once you choose your speaker configuration, use the 
test feature to play a sound through each speaker. 

Libraries

Windows Media Center can be used for a variety of audio options. You can set up various libraries on 
the system to share and access many different types of files. When viewing the Library setup screen, 
select "Add folder to watch" and then click the "Next" button. You will then need to select "Add folders 
on this computer" and then search for files to add to the Library. Put a checkmark next to the box for 
each folder that you want to add to the Library and then click "Next" to add the files. You can create a 
library for music files and picture files, as well as movies. 

Television

When you use Windows Media Center, you are able to watch and record television programming 
using the computer as a DVR. You will need to have a TV tuner card installed in the machine to 
receive broadcast television. If your system does not have a TV tuner card, they can be found at 
online sites, such as Newegg (see Resources). You can also use Windows Media Center to watch 
television programming online, as well as from different rooms within the home. You'll need a Media 
Center Extender (see Resources) to watch programming in a different room

 Setting up your PC as a TV
Step 1

Click "Start," "All Programs" and then "Windows Media Center." Hover the mouse cursor over the 
vertical menu list until an up arrow appears. Click this arrow until "Tasks" is highlighted in the center 
of the screen.
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Step 2

Click the left arrow until "Settings" is highlighted. Click "Settings." Click "General." Click "Windows 
Media Center Setup."

Step 3

Click "Set up Internet Connection." Click "Next." Select "Yes" if your Internet connection is always on. 
Select "No" if you must connect manually. Click "Next." Click "Test" to ensure that the Internet 
connection is working. Click "Next" and "Finish."

Step 4

Ensure that you have a TV tuner installed and that it's connected to the source of programming. Click 
"Set up TV signal." Click "Next." Confirm that the region is correct and select "Yes, use this region to 
configure TV services." Otherwise, select "No, I want to select a different region." Click "Next." Select 
"Configure my TV signal automatically." Click "Next." If the TV signal configuration signal result is 
correct, click "Yes." Otherwise, select "No, I want to try again" or "No, proceed to manual TV setup." 
When the configuration is complete, click "Next" to set up the program guide. Select "Yes" to use the 
guide if you agree to the guide's privacy policy. Select whether or not you agree to the terms of 
service. Enter your ZIP code and click "Next." Deselect any programs in the list that are getting a poor 
signal. Click "Next" and then "Finish."

Step 5

Click "Set up Your Speakers." Click "Next." Select the type of cable you use to connect your speakers 
to your computer. If you're unsure, check your computer's documentation. If you have a laptop, select 
"Built-in." Click "Next." Select the number of speakers you have connected to your computer. If you 
have two speakers or built-in speakers, select "2 speakers." If you have five speakers, select "5.1 
surround speakers." If you have seven speakers, select "7.1 surround speakers." Click "Next." Click 
"Test" to test your speakers; then select whether or not you heard the sounds. Click "Next." If you 
didn't hear the sounds, follow the on-screen instructions to troubleshoot your speakers. Click "Finish."

Step 6

Click "Configure Your TV or Monitor." Click "Next." If you wish to watch video on the current display, 
click "Yes, I see the wizard in my preferred display." If not, choose "No, I want to use a different 
display." Click "Next." Select the display type that is connected to your computer. If you're using a 
laptop, click "Built-in Display." If you're using a CRT monitor, click "Monitor." If you're using a flat 
panel monitor, select "Flat Panel." Otherwise, select "Television" or "Projector." Click "Next." Choose 
the width of your display. Choose "Standard" for a CRT monitor and "Widescreen" for an LCD flat 
panel or laptop monitor. Confirm your resolution and click "Next." Click "Finish."

Step 7

Ensure that the equipment for your wireless network is installed and turned on. Click "Join Wireless 
Network." Select "Yes" to change your wireless network settings. Click "No" to keep your existing 
settings. Click "Next." Click "Yes" to connect to your wireless network if you've chosen to change your 
settings. Select your network from the list. Enter your network WEP or WPA passkey. Click "Next."

http://www.ehow.com/how_5127616_set-up-windows-media-center.html
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WINDOWS PHOTO GALLERY
You can use Windows Photo Gallery to manage your entire video and photo collection. Save, swap, 

label and edit photos.

Step 1

Open Windows Photo Gallery. Click on the Windows button at the bottom left of the desktop. Find the 
Photo Gallery icon on the Start menu and left-click once to open the program.

Step 2

Click "All Pictures" and "Videos" to view everything in your picture library. Thumbnail versions of your 
pictures are displayed in the Photo Gallery window.

Step 3

Click on the Tags button to add tags to your pictures and videos or create new tags. These labels 
help you quickly search through your video and picture collection.

Step 4

Click on "Date" to sort through pictures and videos by their dates. 

Step 5

Click on "Ratings" to give pictures and videos a rating. You can then search through your collection 
based on a five-star rating.

Step 6

Pull down the File menu. Click on "Import from Camera or Scanner" to add new images to your 
collection.

Step 7

Click on the Fix button to access the picture editing controls. You can adjust the color of pictures, as 
well as fix red-eye and crop out unwanted parts of an image.

http://www.ehow.com/how_2036541_use-gallery-vista.html
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 WINDOWS MOVIE MAKER
Using Windows Movie Maker can turn you into an amateur filmmaker, giving you a way to create slide 
shows of your favorite photos, or load and edit movies taken on your digital camcorder. Movie Maker also 
lets you add creative transitions, text and music that can tie the whole show together. 

Step 1

Make sure you have the equipment required to create movies and slide shows using Movie Maker. 
You will need a Mini-DV digital video camera and tapes, a computer that supports a digital video 
connection and an i.LINK port (also known as FireWire or IEEE standard 1394) on your computer. 
Also recommended are a memory card for your camera and a DVD burner.

Step 2

Know the system requirements for using Windows Movie Maker. You need a computer with Microsoft 
Windows XP Home Professional or a later version, a 600 MHz processor and at least 2 GB of free 
hard disk space. You will need an Internet connection and software that can play video files, such as 
Microsoft Windows Media Player 7.0 or later.

Step 3

Familiarize yourself with terms used often by Windows Movie Maker. A "collection" contains audio 
and video clips and pictures you have imported or captured using the software. Your collection will 
organize your content. A "project" is the arrangement and timing information of your clips, transitions 
and any effects or titles you add to the storyboard. Saved projects can be opened later and edited. A 
"movie" is the final project you save. You can save a movie to your computer or a recordable CD, 
send it as an email attachment or save and send it to the Web.

Step 4

Shoot movies using your video camera and then load them into your computer using your i.LINK or 
FireWire cable. If you use an i.LINK cable, Movie Maker will do the work of rewinding your video tape 
and transferring it to your computer. If you don't have a FireWire port on your computer, consider 
adding one.

Step 5

Add transitions, special effects, titles, credits, music, photos and narration to your video by clicking on 
the section of the movie you want to change, using the storyboard mode or the timeline mode. In the 
Movie Tasks pane, which appears on the left while you're working, click on the task you'd like and 
simply enter the information (for titles and credits), choose a special effect or import 
music/audio/photo files that are stored in your computer.

Step 6

Work with separate video clips to create a larger movie. During the download from your video 
camera, Movie Maker will split longer videos into shorter clips that are easier to work with, and then 
add your clips to a collection. You can drag clips from the collection to your storyboard to create a 
movie. You can also trim video clips by dragging a clip from your collection into the storyboard and 
clicking "play" on the preview monitor. When the clip gets to where you want to trim it, click Split Clip. 

http://www.ehow.com/how_2103588_use-windows-movie-maker.html
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This will trim your clip into two separate clips. Delete the portion you don't want by right-clicking it and 
clicking on Delete.

Step 7

Work with two visuals, when necessary or desired, of your movie on Movie Maker-the storyboard and 
the timeline. Use the right-click option when you get stuck, because your solution during the editing 
process will often be there.

Step 8

Convert your finished Windows Movie Maker project into a movie that can be played using Windows 
Media Player and other means. Choose File and Save Movie on the menu bar Windows Movie 
Maker). In the Save Movie dialog box, choose the playback quality.

Step 9

Enter your movie title in the Title box, your name in the Author box, the movie rating in the Rating text 
box and a description in the Description box. Choose OK to open the Save As box. Select the folder 
where the movie will be saved and give the movie a filename.

WINDOWS DVD MAKER

Nowadays, it seems as though nearly everyone downloads music and movies online. However, once you 
have the movies, what will you do with them? Either you can keep them on your hard drive and take up 
valuable space, or you can transfer your files to a DVD. Many people feel that the DVD burning process is 
too complicated for them to understand, but it is actually a relatively simple process.

Step 1

Make sure that you have at least five gigabytes of free space on your hard drive. To check this, go to 
“Start” and select “My Computer.” Look at the “C:” drive and make sure that you see at least 5 GB 
free or something similar.

Step 2

Insert a blank DVD into your DVD drive.

Step 3

If you have “Autoplay” enabled, a popup screen should appear asking you what action you wish to 
take. If so, select “Burn a DVD Video Disc using Windows DVD Maker.” If not, go to Start and then 
“Search” and type in “Windows DVD Maker.” After it appears in the list, select it by clicking on it. The 
Windows DVD Maker screen should appear. If you want, you can “uncheck” the box that says “Don’t 
Show this Page Again.” If you do that, this screen will appear the next time you burn a DVD.

Step 4

http://www.ehow.com/how_4998483_dvds-using-windows-dvd-maker.html
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Click on the button that says “Choose Photos and Videos.” On the next page, you are to select the 
files that you wish to burn. You can click the “Add Items” button at the top and then search through 
various folders on your computer to find the file that you want or you can open the folder that has the 
file(s) you want, “left-click” the mouse and hold it down over the item and then drag the item into the 
blank list in the Windows DVD Maker screen. Either way is acceptable.

Step 5

Go to the bottom of the DVD screen and click inside of the box that is marked “Disc Title.” You can 
replace the date with whatever name you want to give your soon-to-be DVD. If you do not want to go 
too in-depth with this software at this time, skip down to step 8.

Step 6

For the most part, you can leave the “Options” button alone. However, if you choose to click on it, you 
need to understand what the settings mean. For instance:

• “Start with DVD Menu” means that, whenever the DVD is inserted into a player, the home screen 
will appear and you will have the option of selecting Play or which scene you wish to view. 

• “Play Video and End with DVD Menu” means that the movie will start the moment the DVD is 
inserted into the player and return to the home screen when the movie ends. 

• “Play Video in a Continuous Loop” means that the movie will keep playing as long as the DVD is in 
the player. 

• “DVD Aspect Ratio” refers to the screen the movie will play in. 4:3 is the standard video screen for 
the United States, while 16:9 is the international standard. 

• “Video Format” determines which kind of DVD player you disc can play on. “NTSC” refers to 
American DVD players. “PAL” refers to DVD players made abroad. 

• “DVD Burner Speed” refers to how quickly your DVD burning project will take to be completed. 

• “Temporary File Location” is the reason you need at least 5 GB free. When you burn a DVD, your 
computer makes a temporary copy of your new disc and stores it on your main hard drive. If you don’t 
have at least five free, the DVD burning process will be significantly slowed. 

Simply click cancel if you decide to make no changes under Options.

Step 7

Your DVD software will automatically burn DVDs to your “E:” drive. However, if you have a separate 
DVD burner, you can select “DVD Burner” and choose your device instead.

Step 8

Scroll to the bottom and click “Next.” The “Ready to Burn Disc” screen should appear. On this screen, 
you have the option of choosing the look of your DVDs home screen. If this is not important to you, 
you can skip down to step 13.

Step 9

http://www.ehow.com/how_4998483_dvds-using-windows-dvd-maker.html


“Preview” allows you to see what how you DVD will behave in a player once it is completed. “Menu 
Text” allows you to choose the Font that you want your DVDs title— as well as the “Play,” “Scenes” 
and “Notes” buttons—to have. When you click that button, you will see various tabs on the next 
screen. From there, you can change the name of any of the buttons. For example, if you would prefer 
the Play button to be labeled “Happy Dragon Fun Time,” this is where you would type that in. The 
“Notes” button is unique. If you delete the word Notes and keep the Notes box empty, the button will 
disappear entirely on your new DVD. I recommend changing the word Notes to Synopsis and adding 
a summary of your movie to the large, empty Notes box.

Step 10

Click “Change Text” to complete the changes you made or “Don’t Change” to reject them.

Step 11

“Customize Menu” allows you to change the particulars of your DVD. You can change the overall 
shape of the buttons at the “Screen Button Styles” tab or add Back- and Foreground videos to the 
home screen from anywhere on your hard drive. You can even add an audio file of your choice. Click 
“Change Style” to complete the changes you made or Don’t Change to reject them.

Step 12

“Slide show” allows you to create a slideshow to appear when your DVD is inserted into a player. You 
can add music and whatever pictures you want. You can also change the duration that each picture 
stays up on the screen. Click “Change Slide Show” to complete the changes you made or Don’t 
Change to reject them.

Step 13

You should be back to the Ready to Burn Disc screen.

Step 14

On the right hand side of the screen, you should see a list of “Menu Styles.” Select the one that you 
want but keep in mind that each Menu style has its own font and button shape. Click “Burn” to begin 
the DVD burning process or Cancel to exit.

Step 15

After the disc is finished, your computer will ask if you wish to make another copy of the disc. If you 
select “OK” you will then have to insert a new DVD and re-burn the movie. However, you will not have 
to start over completely. If you select “Cancel” or click the red “X” in the corner, you will return to the 
Ready to Burn Disc screen. If you click the red X again, you will be asked to save your project. Name 
the project whatever you wish. Your DVD is now burned and ready to use and you have a copy of the 
specifications you made. If you want to go back later on and re-burn this DVD, all you need to do is 
click the “Saved project file” and have a copy of the film on your hard drive.

WINDOWS SIDEBAR AND GADGETS

This is a long, vertical bar that is displayed on the side of your desktop. It contains mini-programs called 
gadgets, which offer information at a glance and provide easy access to frequently used tools. For 



example, you can use gadgets to display a picture slide show, view continuously updated headlines, or 
look up contacts.

Step 1

Open the Windows Vista Sidebar. From the Start menu, select Accessories and then Windows 
Sidebar. The Sidebar now displays on the right side of your desktop.

Step 2

View the current gadgets on the Sidebar. Default gadgets include a picture slideshow, a clock and the 
weather.

Step 3

Add a new gadget to the Sidebar. Click on the "+" icon in the upper left of the Sidebar to open the 
Gadgets window. Double-click on a gadget to add it.

Step 4

Adjust the settings for a gadget on the Windows Vista Sidebar. Move the mouse cursor over a 
gadget, such as the weather gadget. Click on the white wrench icon that appears to the right of the 
gadget to open the settings dialog box for the gadget. Make and save your adjustments.

Step 5

Delete a gadget from the Sidebar. Move the mouse cursor over a gadget. Click on the white "x" icon 
that appears to the right of the gadget.

WINDOWS CALENDAR
Windows Calendar has many capabilities that will simplify your life. Keep reading to find out how to use 
the calendar program to help you manage all of your appointments and obligations.

Step 1

Record the dates, times and places of your appointments and engagements. You can record the 
regular information such as time, date and place. To help manage your schedule on a greater level, 
Windows Calendar allows you to set completion deadlines for projects and their level of priority so 
you won't forget anything. Set the calendar to remind you when something in your schedule is 
approaching however far in advance you like.

Step 2

http://www.ehow.com/how_2189975_use-windows-calendar-vista.html
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Set up the appointments that are recurring. Enter in the information once, and set the calendar to 
record that same appointment repeatedly on the same date and time. This way, you save time by not 
having to enter the same thing many times.

Step 3

Write emails now even if they don't need to be sent now. For example, if you want to send someone a 
reminder about your meeting that is four weeks away, you can write the email now. Then, set the 
calendar to email it when you want the person to get it and it will automatically do so.

Step 4

Share your calendar with other people who share the same computer, even if everyone has a 
separate account with Windows Calendar. Using this tool, you will be able to see if appointments that 
you have will conflict with your son's soccer game or your daughter's dance recital, for example. 
Parents can even edit their children's calendar if they need to.

Step 5

Use iCalendar to publish your calendar to the Internet. You can also export your information to and 
from other applications. With this feature, you can view your calendar alongside the calendars for 
other people or groups who have also published theirs. If you only want to let select people view your 
calendar, you can password protect it and designate who gets to see your schedule. 

WINDOWS CONTACTS

Contacts are used with Email.  It is especially useful to create group mailings lists to send email to a 
regular group of individuals in your Address/Contacts folder. There is a specific procedure you can follow 
to create a group mailing list using Windows Mail and Windows Contacts.

Step 1

Launch the Windows Contacts application by selecting "Start>All Programs>Windows Contacts."

Step 2

From the Toolbar, click the "New Group Contact" button.

Step 3

http://www.ehow.com/how_4815283_mailing-list-using-windows-mail.html
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In the "Group Name" field, type the name of your group (e.g. Travel Club).

Step 4

Click the "Add to Contact Group" button to add existing Windows Mail contacts to your group. When 
the Window Contact folder opens, select the contacts you wish to add to your group.

Step 5

Click the "Create New Contact" button to add a new contact to your group and the Windows Mail 
Contact folder simultaneously.

Step 6

In the "Contact Name" field, type the name of the contact, followed by his address in the "Email" field. 
Then click the "Create for Group Only" button if you want to add a new contact to your group mailing 
list without adding the contact to the Windows Mail Contact folder. Click "OK" to finish creating your 
group.

Adding the New Contact Group Button to Windows Contacts

Step 1

Follow the steps in this section only if the "New Contact Group" button is not visible on the Windows Contacts toolbar. 
Launch the Windows Contacts application by selecting "Start>All Programs>Windows Contacts."
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Step 2

Right-click the Preview Pane section of the "Windows Contacts" folder to view the shortcut list. Select the "Customize 
This Folder" option from the list.

Step 3

In the "Customize" tab, select "Contacts." Click "OK" to close the window.

Sending an Email Message to a Group Using Windows Mail

Step 1

Launch the Windows Mail application by selecting "Start>All Programs>Windows Mail."

Step 2

From the Windows Mail toolbar, click the "Create Mail" button to start a new mail message.

Step 3

Click the "To" recipient button. Highlight the name of the group mailing list you created in Windows Contacts. Click the 
"To," "CC" or "BCC" button to address the message to your recipients. Click "OK."

WINDOWS MAIL
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Setup

Step 1

Open up Windows Mail. You can find the program in the Start Menu, the system tray, the desktop or 
the Quick Launch bar, depending on the settings you've chosen.

Step 2

Click on "Tools" and then open up the "Accounts" window.

Step 3

Click on "Add" and choose to create an email account instead of a newsgroup account or directory 
service. Click on "Next."

Step 4

Type in the name that you'd like all of your outgoing mail to be labeled. This is different from your 
personalized email signature, which goes at the bottom of each of your email messages. Click "Next."

Step 5

Type in your email address. Don't worry if it's an Internet email address with a site like Gmail or 
Yahoo! It doesn't make a difference to Windows Mail.

Step 6

Select the incoming server type. POP3 is pretty much the standard, but you should check with your 
account provider before selecting a type. Usually email sites will have all of this information on a 
specific page. You can hunt around until you've found the right one.

Step 7

Type in the names of your email provider's incoming and outgoing mail servers. Again, call your 
provider or look on their website for these addresses. Click on "Next."

Use

Step 1

Open the Start menu. Click on the Windows icon in the lower left corner of the desktop.

Step 2

Click on the Email icon, located directly under the IE icon.

Step 3
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Check your "Inbox." Expand "Local Folders" and then click on Inbox to review new messages. You 
can also look over your outgoing mail, saved messages and the usual suspect email pieces.

Step 4

Monitor newsgroups. Click on "Windows Communities" to keep track of newsgroups and forums that 
you are interested in.

Step 5

Send Mail. Click on the Create Mail button while you are in the "Local Folder." Write your message 
and hit "Send."

Step 6

Check Contacts. While in the "Local Folder," click the Contacts button. This opens your Contacts list.

WINDOWS MEETING SPACE
You can use the "Windows Meeting Space" feature of Vista to pool resources with groups of up to 10 
people at a time. Join or start a meeting in "Windows Meeting Space" to share files and programs, to 
group-edit documents or to hook up to a network projector for a presentation. Follow these steps to find 
out how.

Step 1

Open "Window Meeting Space" from the "Start" menu. View the "Program Files" and click the 
"Windows Meeting Space" icon.

Step 2

Sign into the "People Near Me" feature to enable others to send you invitations to "Windows Meeting 
Place" meetings. Open the "Control Panel" from the "Start" menu, click "Network and Internet" and 
then click "People Near Me." Click the "Sign In" button, click "Sign In to People Near Me" and then hit 
the "OK" button. 

Step 3

Join a "Windows Meeting Space" meeting. If you’ve been sent an invitation, click "Open an Invitation 
File." If there's a meeting already taking place, you can click "Join an Invitation Near Me," enter the 
meeting password and click the "Arrow" button.

Step 4

Start a meeting of your own. Click "Start a New Meeting" and type in a password that's at least 8 
characters long.

Step 5
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Select names of people to invite them to a meeting. Click "Invite People" and check the boxes next to 
the names of the people you signed into under the "People Near Me" feature. Click the "Send 
Invitations" button.

Step 6

Invite people to your meeting with an e-mail. Click "Invite People" and then click the "Invite Others" 
button. Click "Send an Invitation E-mail."

Step 7

Make an invitation file with the information needed for others to join your meeting. Click the "Invite 
People" button and then click on "Invite Others." From the "Invite Others" menu, click "Create an 
Invitation File." Save the file. Then, send it in an e-mail as an attachment.

Step 8

Share programs and your desktop with meeting members. Click "Share a Program or Desktop," and 
select what program or item you want to share.

Step 9

Share a document for others to view and edit. Click "Add a Handout." Choose what file you want to 
share and Hook-up to a projector on your network in order to give a presentation. While in a meeting, 
click the "Options" button at the top right-hand side of your screen. Click on "Connect to a Projector" 
and complete the instructions.

WINDOWS DEFENDER
Spyware and other invasive software can perform tasks and collect information from you without your 
consent. You can use the Windows Defender Feature of Vista to alert you when these types of software 
try to invade you computer. The Windows Defender Feature will also check for updates and regularly 
scan you computer to isolate and remove viruses and spyware. Follow these steps to find out how.

Step 1

Open Windows Defender. Click the "Start" button and select "Windows Defender" from the Program 
files.

Step 2

Turn on Windows Defender. Open the "Tools" menu at the top of your screen and select "Options" In 
the "Administrative Options" menu. Check the box that says "Use Windows Defender." Click the 
"Save" button.

Step 3

Scan for spyware on your computer. When you open Windows Defender, you'll see a button that says 
"Scan" with a drop-down menu next to it. Click the "Scan" button to perform a "Quick Scan" of the 
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most likely locations for spyware. Or, you can open the drop-down menu and select "Full Scan," 
"Custom Scan" or "Advanced Scan."

Step 4

Choose to ignore or quarantine spyware or malicious software. After Windows Defender performs a 
scan, select "Quarantine" to isolate spyware or to remove it later. If the software has been incorrectly 
deemed harmful, select "Ignore" to let it run as normal.

Step 5

View your quarantined items by opening the "Tools" menu and clicking "Quarantined Items." Click the 
"Remove" or the "Remove All" button to delete the quarantined item permanently. You can also 
release an item from quarantine by clicking the "Restore" button. 

Step 6

Use Windows Defender real-time protection to constantly monitor your computer for invasions of 
unwanted software. From the "Tools" menu, click "Options." Select "Real-time Protection Options." 
Choose "Use Real-time Protection."

Step 7

Enable Windows Defender to automatically check for updates to virus and spyware definitions. From 
the "Tools" menu, click "Options." Check the "Automatically Scan My Computer" check box under the 
heading "Automatic Scanning."

SHARING FILES BETWEEN MICROSOFT WORKS AND 
MICROSOFT® OFFICE
Why won't this file open?
Perhaps a friend sent you an e-mail message with an attached Microsoft® Office Word document that you 
want to read, or you brought a Microsoft® Office Excel workbook home from the office and want to work 
on it. It's frustrating when you can't get these files to quickly open in Works! Why won't they just open like 
the others you typically work with? Well, let's look at some scenarios and discover how Works can work 
well with Microsoft Office. 

Scenario 1: Double-clicking the file won't open it
Simply double-clicking an Office Word or Office Excel file in an e-mail message or in My Documents may 
not work. You might see a message that the file cannot be opened. 
If you get a message like this when you try to open an Office file in Works, just click Cancel, and then 
follow these steps: 

Open the appropriate Works program. For this example, open Spreadsheet. 

Click File, and then click Open. 

Browse to the folder that contains your file. 
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If the file is an e-mail attachment, you need to save it to your computer first. 

In the Files of type list, click the file type for the program that created the file; for example Excel 
(*.xl*) for an Excel workbook. 

Now just click the file, and then click Open.
NOTE: Excel workbooks typically have multiple pages, called worksheets. Works Spreadsheet can 
open only one Excel worksheet at a time, so you will be asked which worksheet you want to open.

Ah, but maybe the file uses features of Office that Works does not support. This leads us to our next 
scenario.

Scenario 2: Part of the file is missing after I open it in Works
When you open an Office file in Works, some parts of the file might be missing. In this case, the following 
message might appear. 

What's a person to do in this case? 

If you do not need the missing parts, say you just want to look at the data in the Excel worksheet or print 
the Word document without the comments; the best thing to do is to save the original Office file in a 
generic format. For Word, you can save it as an .rtf or .txt file, and for Excel, you can save it as a tab-
delimited.txt file. 

Whoa! What in the world are .rtf and .txt? 

Okay, let's walk through creating these files and along the way explain what they are: 

In Word or Excel, click File, and then click Save As. 

In the Save as type list, click one of the following:
- Rich Text Format (*.rtf). This format retains formatting features such as text fonts and colors and is 
your best choice for Word files.
- Plain Text (*.txt) in Word or Text (Tab delimited) (*.txt) in Excel. This is the simplest format for 
Word Processor, Spreadsheet, or Database. When you save a worksheet in this format, the columns 
are separated by tabs.

After you save the file as one of the generic file types, you can open it in Works: 

Open the appropriate Works program, Spreadsheet for example. 

Click File, and then click Open. 

Browse to the folder that contains your file. 

In the Files of type list, click the file type. For example, Text (*.txt). 



If you need the advanced features in the Office file, then the solution is to upgrade to Office to gain 
access to all the advanced features. 

Scenario 3: What about opening Works files with Office?
Okay, what if you wrote a document using Works Word Processor, or a spreadsheet using the Works 
Spreadsheet, and want to open the file in Office? With current versions of Works and Office, you have two 
options. 

The first is to save the Works file normally and then open it in Office: 

In the appropriate Office program, click File, and then click Open. 

Browse to the folder that contains the Works file. 

In the Files of type list, choose All Files (*.*). 

Select the Works file that you want to open.
The second is to save the Works file in the appropriate Office format: 

In the Works program, click File, and then click Save As. 

In the Save as type list, click the appropriate Office program. For a Works Word Processor 
document, click Word 97-2003 (*.doc) or Word 2007 (*.docx). For a Works Spreadsheet, click Excel 
97-2003 (*.xls) or Excel 2007 (*.xlsx). 

Open the file in Office!

If you are using versions of Works older than Works 7.0, then you can download file converters from the 
Works Web site: 
http://www.microsoft.com/products/works/downloads.mspx

The available converters are:

The Office 12 converters allow users of Works 9 to open and save Office 12 files. 
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The Works 6.0 converter lets users of Works 2000, Works 4.x, Microsoft Word 2000, Word 97, and earlier 
versions of Word read documents created in Works 6.0. This converter is for computers running Microsoft 
Windows 98 and Windows Me. 

The Word 2000 Batch Works file converter, included in Works Suite 2000, helps you convert all of your 
Works document files into Word 2000 format. 
The Works 2000 to Word Converter lets users of Word 2000, Word 97, or Works 4.x open Works 2000 
Word Processor files. This converter is for computers running Windows 98 and Windows Me.

To recap
Office and Works can work very well together if you remember to do the following:

Open an Office file from a Works program instead of double-clicking it.
Save an Office file as a generic format before opening it in Works.
Open a Works file from an Office program, or use Works to save it as an Office file.


